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Introduction TC "Introduction" \f C \l "1" 
JSHOP2 is a domain-independent planning system based on ordered task decomposition, a modified version of HTN planning that involves planning for tasks in the same order that they will later be executed [1, p.2].  Although JSHOP2’s command line interface is sufficient for finding plans given a problem, it makes it difficult to conceptualize the steps taken by the planner during the plan-finding process.  The graphical user interface (GUI) for JSHOP2 addresses this issue by providing the user a way to graphically depict the task decomposition trees produced by JSHOP2.  The graphical interface for JSHOP2 is very similar to the one for SHOP2 [2], JSHOP2’s predecessor.  However, whereas the GUI for SHOP2 only reported 4 different types of task actions, JSHOP2’s GUI reports 6 (see p. 4, The Status Bar).
Using the Interface TC "Using the Interface" \f C \l "1" 
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Figure 1 – The graphical interface for JSHOP2
The actions taken by JSHOP2 to find plans to a problem are represented in the GUI as a series of steps (p. 4, The Status Bar).  These steps can be traversed in a forward direction by using the control buttons (p. 7).  The main window of the interface (p. 3) graphically depicts the task decomposition tree.  Information about the state of the world and actions taken at each node is displayed in the current state and step information windows (p. 6).
The Main Window TC "The Main Window" \f C \l "1" 
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Figure 2 – The main window
The main window of the GUI displays the task decomposition tree, and every node in the tree represents a task atom.  The task atoms that appear in the tree are always the ground instances of the top tasks that were used to find the current plan.  The nodes in the tree can be large or small.  A large node is a visited node, while small nodes are unvisited nodes.  The nodes can also be yellow or blue.  A yellow node indicates that it is part of a total ordering among its siblings.  A blue node indicates that it is unordered (see figure 3).  If the cursor is held over any node in the tree, the ordered and visited status of that node will be displayed in a pop-up menu.
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Figure 3 – Illustrations of the different node types.  Yellow nodes are ordered while blue nodes are unordered.  Large nodes are visited while small nodes are unvisited.
The leaf nodes have a number surrounded by brackets preceding their task atom name that indicates the position of that primitive action in the sequence of actions that will eventually make up the plan (see figure 4).  Initially, every node is assumed to be a leaf node when it is first encountered.  If the task represented by the node turns out to be a complex task, the leaf numbering is removed from that task and it is decomposed into subtasks.
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Figure 4 – An example of a leaf node.  The “[1]” indicates that in the resulting plan, this action will be the first action to be performed.

The Status Bar TC "The Status Bar" \f C \l "1" 
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Figure 5 – The status bar detailing the actions taken during the current step

The status bar informs the user what action was taken at every step in the plan-finding process.  Six types of actions can be reported:
1. The planner is setting the goal tasks to be accomplished

2. The planner is currently trying a task
3. The planner has reduced a task
4. The state has been changed by a primitive task

5. The planner is backtracking from a task
6. The planner has found a plan
The first action taken by the planner for any problem is to set the goal tasks.  During this step, all the goal tasks are added to the task decomposition tree.

When the planner is trying a task, it means that the task is being encountered and attempted for the first time.  At this point, the planner does not know whether the task is primitive or complex.  That information will be available during the next plan step.  What is known, however, is the state of the world when this task is being attempted.
After a task is tried, it is immediately followed by either a reduced action or a state changed action.  If the task that was tried was a complex task, it is reduced into its subtasks during the next step of the plan-finding process.  If the task was primitive, however, the state of the world is updated in the next step.

If the current task decomposition tree fails to yield a plan, or if a plan has been found and the planner is about to find the next plan, a backtracking action will be reported in the status bar.  The task atom from which the planner is backtracking will always be shown.  As the planner backtracks, nodes will be removed from the tree to represent the effects of the backtracking action.
Lastly, after the state of the world has been changed by a primitive task, if a plan is found, the planner will notify the user that a plan has been found in the status bar.  As such, a plan found action will always be preceded by a state changed action.  When a plan is found, a dialog box will be displayed that sequentially lists the primitive actions comprising the plan (see figure 6).  The plan dialog box will show what number the current plan is and how many total plans can be found in the problem.
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Figure 6 – The plan dialog box is displayed whenever a plan is found.  The user can keep these windows open to compare different plans when multiple plans are found.

The Current State Window TC "The Current State Window" \f C \l "1" 
[image: image14.png]CurrentState  (total:9)

[(m10c20050500)
(m10c00010.100)
(m10c10010.100)
(m_unit0.0)
(m_unit10)
(m_unit20)
(m_playerid 0.0 1.0)
(m_playerid 1.0 1.0)
(m_playerid 20 1.0)




Figure 7 – The window displaying the current state

The current state window displays the state of the world when the selected task atom was encountered in the plan-finding process.  If the selected task atom is a primitive task, the current state displayed here will NOT reflect the changes made to the state by the primitive task.  That information is displayed in the adjacent step information window (see the Step Information Window section below).
The Step Information Window TC "The Step Information Window" \f C \l "1" 
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Figure 8 – The step information window.

The step information window displays pertinent information about the current step in the plan-finding process.  During a reduced step, this window will display the name of the method used to decompose the complex task.  During a state changed step, this window will display the changes made to the current state by the primitive task (see figure 8).  When changes are made to the state, the step information window will list the deleted atoms, the added atoms, the deleted protections, and the added protections (if any).
The Control Buttons TC "The Control Buttons" \f C \l "1" 
The GUI represents the plan-finding process as a series of steps (see Status Bar section above).  The control buttons allow the user to iterate through these steps.  The description of the various buttons and their functions are as follows:
[image: image16.png]Multi-step size:
12

Multi-Step





Figure 9 – The multi-step button and its step size input field
The multi-step button allows the user to step forward in the plan-finding process by the number of steps designated in the multi-step size field.  This feature allows quick access to a specific step number.  If the step size oversteps a point where a plan is found, the execution is stopped when the plan found step is encountered.
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Figure 10 – The single-step button

The single step button allows the user to move forward in the plan-finding process by a single step.  Use this button in conjunction with the multi-step button to quickly locate a step of interest or to iterate through the steps one at a time without resetting the multi-step size field.
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Figure 11 – The run button

Pressing the run button causes execution to automatically iterate through the steps in the plan-finding process until either a plan is found or all of the steps have been traversed.  After a plan is found, pressing the run button again will cause execution to iterate through the remaining steps until another plan is found or all of the steps have been traversed.  In cases when multiple plans can be found, pressing the run button multiple times will allow the user to quickly jump from plan to plan.
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Figure 12 – The restart button

The restart button resets the current point in the plan-finding process to the beginning.  Because the GUI only allows the user to traverse the steps in a forward direction, a back-step can be simulated by restarting and then multi-stepping to the desired point.
The Progress Bar TC "The Progress Bar" \f C \l "1" 
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Figure 13 – The progress bar
The progress bar shows how far along the user is in the plan-finding process.  It displays the number of the step currently being executed along with the total number of steps for the problem.  Use these step numbers along with the multi-step button to quickly jump to a point of interest in the plan-finding process.
The Menu Bar Items TC "The Menu Bar Items" \f C \l "1" 
The File Menu TC "The File Menu" \f C \l "2" :

[image: image21.png]File | View

Bxt | (move (20)0.10.1) into t

(rdspon (0.01.02.0)0.1 0.1





Figure 14 – The file menu items

The file menu currently has a single item, the exit menu item.  Use this to exit the GUI.

The View Menu TC "The View Menu" \f C \l "2" :
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Figure 15 – The view menu items
The view menu has two items: the Leaf Node Tracker menu item and the Show State menu item.  Selecting Leaf Node Tracker will display the leaf node tracker dialog box (see figure 16).  Selecting Show State will open up a dialog box listing the state atoms for the currently selected node (see figure 17).
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Figure 16 – Leaf Node Tracker dialog box

Use the Leaf Node Tracker to quickly find a leaf node of interest or to simply see the order in which the leaf nodes were visited by the planner.  The total number of leaves in the tree is displayed at the top.  Type in the number of the leaf node you want to view in the leaf number text field and press the Find button to jump to that node.  Pressing Prev or Next will jump to the leaf node that comes sequentially before or after the current one.
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Figure 17 – Show State dialog box
The State dialog box shows the same information as the Current State Window (see figure 7) except in a larger, free-floating dialog box.  Simply click on the node of interest and select Show State from the view menu to open its state dialog box.  Use these dialog boxes to compare the states of two or more nodes side by side.
Conclusion TC "Conclusion" \f C \l "1"  
The goal of every graphical user interface is to provide the user with a fast and intuitive way to exchange information with the underlying program.  In the case of the GUI for JSHOP2, the role of the interface is to depict a graphical representation of the process taken by the program to generate the output.  This type of information is useful for debugging purposes and for understanding the control flow of the planning algorithm.  In developing the GUI, much consideration was given whenever a decision had to be made between making the interface more informative and making it easier to use.  For example, the decision was made to not accurately model task lists with partial orderings because to do so would overcomplicate the task decomposition tree while conferring minimal benefits.  Future enhancements to the GUI may include the ability to step backwards in the planning process, synchronization with JSHOP2 in order to provide debugging capability for examples that run indefinitely, and the ability for the user to dynamically direct the path of task decomposition.
Availability TC "Availability" \f C \l "1"  
The GUI for JSHOP2 will be available for download with the JSHOP2 package at http://sourceforge.net/projects/shop.  
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